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Lesson files
Each lesson has its own folder 
inside the Lessons folder. You will 
need to copy these lesson folders 
to your hard drive before you can 
begin each lesson.

Where are the lesson files?
Purchasing this Classroom in a Book gives you access to the lesson files that you’ll 
need to complete the exercises in the book, as well as other content to help you 
learn more about Adobe software and use it with greater efficiency and ease. The 
diagram below represents the contents of the lesson files directory, which should 
help you locate the files you need. Please see the Getting Started section for full 
download instructions.

Adobe Press
Find information about other 
Adobe Press titles, covering the 
full spectrum of Adobe products, 
in the Online Resources file.

Online resources
Links to Adobe Community Help, product 
Help and Support pages, Adobe certification 
programs, Adobe TV, and other useful online 
resources can be found inside a handy HTML 
file. Just open it in your web browser and 
click on the links, including a special link 
to this book’s product page where you can 
access updates and bonus material.



iv  Contents

Contents

GETTING STARTED	 1

About Classroom in a Book. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  2

What’s in this book. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          2

Prerequisites. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                3

Installing Adobe Audition. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   3

Starting Adobe Audition. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    4

Accessing the Classroom in a Book files. . . . . . . . . . . . . . . . . . . . . . .                      4

Restoring default preferences. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               5

Additional resources. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        5

Audition and social media. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   6

Adobe certification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         7

1	 Audio Interfacing 	 8

Audio interface basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      10

Mac OS X audio setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      11

Windows setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            14

Testing inputs and outputs with Audition  
(Mac or Windows). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          17

Using external interfaces. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   19

2	 The Audition Environment 	 22

Audition’s dual personality . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

The Audition Workspace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   25

Navigation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                35

3	 Basic Editing	 46

Opening a file for editing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   48

Selecting a region for editing and changing its level . . . . . . . . .        48

Cutting, deleting, and pasting audio regions. . . . . . . . . . . . . . . . .                49



Adobe Audition CC Classroom in a Book  v

Cutting and pasting with multiple clipboards. . . . . . . . . . . . . . . .               52

Extending and shortening musical selections. . . . . . . . . . . . . . . .               54

Simultaneous mixing and pasting. . . . . . . . . . . . . . . . . . . . . . . . . . .                          56

Repeating part of a waveform to create a loop. . . . . . . . . . . . . . .              56

Showing waveform data under the cursor. . . . . . . . . . . . . . . . . . .                  58

Fading regions to reduce artifacts. . . . . . . . . . . . . . . . . . . . . . . . . . .                          58

4	 Signal Processing 	 62

Effects basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              64

Using the Effects Rack. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      64

Amplitude and Compression effects. . . . . . . . . . . . . . . . . . . . . . . . .                        69

Delay and echo effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     80

Filter and EQ effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        82

Modulation effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         88

Noise reduction/restoration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                91

Reverb effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             91

Special effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             95

Stereo imagery effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     101

Time and Pitch effect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      103

Third-party effects (VST and AU). . . . . . . . . . . . . . . . . . . . . . . . . . .                            106

Using the Effects menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    108

Managing presets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          115

5	 Audio Restoration 	 118

About audio restoration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    120

Reducing hiss. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              120

Reducing crackles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         122

Reducing pops and clicks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  123

Reducing broadband noise . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                124

De-humming a file. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         126

Removing artifacts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         127

Manual artifact removal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    129

Alternate click removal. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     130

Sound removal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            131



vi  Contents

6	 Mastering	 134

Mastering basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           136

Step 1: equalization. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        136

Step 2: dynamics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           138

Step 3: ambience. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          139

Step 4: stereo imaging. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     140

Step 5: “push” the drum hits; then apply the changes. . . . . . .        141

Mastering diagnostics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 142

7	 Sound Design 	 148

About sound design. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       150

Creating rain sounds. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                       150

Creating a babbling brook . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 152

Creating insects at night. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                   152

Creating an alien choir. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     153

Creating sci-fi machine effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                              154

Creating an alien drone flyby. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               156

Extracting frequency bands. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                158

8	 Creating and Recording Files 	 162

Recording into the Waveform Editor. . . . . . . . . . . . . . . . . . . . . . .                        164

Recording into the Multitrack Editor. . . . . . . . . . . . . . . . . . . . . . .                        167

Checking remaining free space. . . . . . . . . . . . . . . . . . . . . . . . . . . .                             169

Drag-and-dropping into an Audition Editor. . . . . . . . . . . . . . . .                 170

Importing tracks as individual files from an audio CD. . . . . . .        172

Importing tracks as a single file from an audio CD. . . . . . . . . .           173

Saving a template. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173

9	 Multitrack Editor Orientation 	 176

About multitrack production. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               178

Multitrack and Waveform Editor integration . . . . . . . . . . . . . . .                178

Changing track colors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      180

Loop selections for playback. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               181

Track controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                              181

Channel mapping in the Multitrack Editor . . . . . . . . . . . . . . . . .                  191

Side-chaining effects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      193



Adobe Audition CC Classroom in a Book  vii

10	 The Multitrack Mixer View 	 196

Mixer view basics. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          198

11	 Editing Clips 	 206

Creating a DJ-style continuous music mix (mixtape)  
with crossfading. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           208

Mixing or exporting a collection of clips as a single file. . . . .      210

Selecting and merging all clips in a track into a  
single file. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                  211

Editing for length. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                          212

Clip edits: Split, Trim, Volume. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                               217

Extending a clip via looping. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                220

12	 Creating Music with Sound Libraries 	 222

About sound libraries. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      224

Getting started. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                            224

Building a rhythm track. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                    226

Adding percussion. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         228

Adding melodic elements. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  229

Using loops with different pitch and tempo . . . . . . . . . . . . . . .                230

Adding effects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             232

13	 Recording in the Multitrack Editor 	 234

Getting ready to record a track. . . . . . . . . . . . . . . . . . . . . . . . . . . .                             236

Setting up the metronome. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 237

Recording a part in a track . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                 239

Recording an additional part (overdub). . . . . . . . . . . . . . . . . . . .                     239

“Punching” over a mistake. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  240

Composite recording . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                      241

14	 Automation	 246

About automation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         248

Clip automation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           248

Track automation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                         253



viii  Contents

15	 Mixing 	 262

About mixing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                             264

Testing your acoustics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                     264

The mixing process. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                        267

Exporting a stereo mix of the song . . . . . . . . . . . . . . . . . . . . . . . .                         284

Burning an audio CD of the song. . . . . . . . . . . . . . . . . . . . . . . . . .                           285

Exporting to SoundCloud. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                  285

Index	 288

BONUS Lesson 16 CAN BE DOWNLOADED FROM THE LESSON & UPDATE 
FILES TAB ON YOUR PEACHPIT ACCOUNT PAGE

16	 Audio/Video Applications 	 BL-2

Importing a video. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . BL-4

Automatic Speech Alignment. . . . . . . . . . . . . . . . . . . . . . . . . . . . .                            BL-5

Audition integration with Adobe Premiere Pro . . . . . . . . . . . .           BL-7

Bonus chapters mentioned in this eBook are available after the index



Adobe Audition CC Classroom in a Book  1

GETTING STARTED

Adobe Audition CC is a professional audio application that combines 
advanced digital audio editing and multitrack recording in the same program. 
This unique approach integrates the two elements so that, for example, audio 
used in a multitrack project can be edited with great detail in the digital audio 
editor, and then be transferred back to the Multitrack Session. Mixdowns 
(mono, stereo, or surround) exported from the Multitrack Session are available 
automatically within the digital audio editor, where a variety of mastering tools 
are available to polish and “sweeten” the mix. The final mix can then be burned 
to a recordable CD, which is created according to the standard Red Book 
specification, uploaded to the SoundCloud file-sharing service, or converted 
into “web-friendly,” data-compressed formats like MP3 and FLAC. In addition, 
the Multitrack Editor has a video window that enables recording sound tracks 
and narration in Audition while previewing HD video. 

Audition also integrates with Adobe Premiere Pro and After Effects via Adobe 
Dynamic Link. You can export mixes from Audition, but also, both Adobe 
Premiere Pro and After Effects will reflect edits you make in Audition as a 
project progresses. You can even open up a multitrack Audition project from 
within Adobe Premiere Pro and After Effects and edit individual tracks, and 
then incorporate those edits into your video project.

Audition is a cross-platform, 64-bit native application that runs equally well on 
Macintosh or Windows computers. Thanks to combining two programs within 
a single, integrated application, Audition has multiple uses, including restoring 
audio, multitrack recording for musicians, mastering, sound design, broadcast, 
video-game sound, narration and voice-overs, file format conversion, small-
scale CD production, and even forensics. Fortunately, all of these features are 
available in a clean, easy-to-use, straightforward interface whose workflow has 
benefited from over a decade of continuous development and refinement.

The latest version, Audition CC, deepens the level of integration with Adobe 
Premiere Pro and After Effects for easy exchange of files and even complete 
sequences. This greatly simplifies the process of creating a sound track that 
reflects changes in the video due to editing. Significant editing enhancements, 
particularly with respect to audio restoration, as well as advanced metering for 
broadcast and other applications are also included. Audition’s second-generation 
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Automatic Speech Alignment process greatly simplifies ADR. Long-time Audition 
users will appreciate the many little extras that enhance workflow and audio quality, 
whereas those new to Audition will welcome its depth and flexibility.

About Classroom in a Book
Adobe Audition CC Classroom in a Book is part of the official training series for 
Adobe graphics, audio, and video publishing software developed with the support 
of Adobe product experts. The lessons are designed to let you learn at your own 
pace. If you’re new to Adobe Audition, you’ll learn the fundamental concepts and 
features needed to start mastering the program. And, if you’ve been using Adobe 
Audition for a while, you’ll find that Classroom in a Book teaches basic to interme-
diate features, and includes tips and techniques for using the latest version of the 
application for a wide variety of projects.

Although each lesson focuses on providing step-by-step instructions to reach specific 
goals, there’s room for exploration and experimentation. You can follow the book 
from start to finish, or do only the lessons that match your interests and needs. 
Each lesson offers an introduction that explains what you can expect to learn from 
a chapter and concludes with a review section summarizing what you’ve covered.

What’s in this book
This edition covers many new features in Adobe Audition CC and how to apply 
them optimally in real-world situations. It addresses audio and music professionals 
who depend on Audition’s tools to accomplish a variety of tasks, as well as videog-
raphers who want to become more involved in the process of creating, editing, and 
sweetening audio intended for video productions.

The book is organized into three parts. The introduction starts with how to get 
audio in and out of Audition on Mac and Windows platforms, and then progresses 
to an overview of the Audition Workspace—a collection of modules, each dedi-
cated to specific tasks, that you can open, close, and rearrange, depending on the 
nature of the project, to optimize workflow and efficiency. The second part con-
centrates on digital audio editing in the Waveform Editor and covers such topics 
as editing, signal processing and effects, audio restoration, mastering, and sound 
design. To segue into the third part, it also covers recording and integration with 
the Multitrack Editor.

The final section covers the Multitrack Editor in detail, including editing, auto-
mation, creating music with sound libraries, and in-depth coverage of mixing. 
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Throughout the book, examples using digital audio clips created specifically for 
this book provide practical, hands-on experience that brings to life the theory 
presented in these pages. Even nonmusicians will learn how to create music using 
sound libraries and loops in conjunction with Audition’s extensive toolset for sound 
creation and editing. You’ll also learn how to do rough testing of your room acous-
tics prior to mixing, using the tools within Audition.

As you progress through the lessons, you’ll also discover many time-saving features 
Audition offers, such as file conversion, automation, Multitrack and Waveform Editor 
integration, clip automation, time-stretching, and more. All of these functions can 
help you meet deadlines more easily than ever before—and that alone is a good rea-
son to become familiar with Audition’s workflow, capabilities, and user interface.

Prerequisites
Before you begin to use Adobe Audition CC Classroom in a Book, you should have a 
working knowledge of your computer and its operating system. Make sure that you 
know how to use the mouse and standard menus and commands, and also how to 
open, save, and close files. If you need to review these techniques, see the help files 
and other documentation included with your Microsoft® Windows® or Apple® Mac® 
OS X system. It’s also highly recommended that you read over the introduction to 
the Audition manual that covers digital audio basics.

You’ll also need the ability to get audio in and out of your computer. Virtually all 
computers include onboard audio capabilities (audio input for recording, and 
internal speakers or a headphone jack for monitoring), but be aware that these 
use consumer-grade components, and although adequate, will not showcase what 
Audition can do to the fullest extent. Professional and “prosumer” audio interfaces 
are available at very reasonable costs, and are recommended not just for doing the 
lessons in this book, but also for any future audio work involving computers.

Installing Adobe Audition
Before you begin using Adobe Audition CC Classroom in a Book, make sure that 
your computer is set up correctly and that it meets the necessary system require-
ments for software and hardware. You must subscribe to Adobe Creative Cloud to 
obtain Adobe Audition CC software, and then install it from Adobe Creative Cloud 
onto your hard disk. For system requirements and complete instructions on install-
ing the software, visit www.adobe.com/support. 

http://www.adobe.com/support
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Audition is a very efficient program, and its 64-bit native operation takes full advan-
tage of modern processors and memory handling. However, as with most audio and 
video programs, having sufficient RAM is essential for a smooth computing experi-
ence. Although Audition will run with 1 GB of RAM, for multitrack recording 2 GB 
is better, and 4 GB is preferable. The 64-bit versions of Mac OS X and Windows 7/8 
have no practical limitation on how much RAM they can address, so 8 GB of RAM 
or more is highly recommended. For more information on system requirements, 
please go to www.adobe.com/products/audition/tech-specs.html.

Starting Adobe Audition
You start Audition the same way as you do most software applications. 

•	 To start Adobe Audition in Windows 7 (64-bit): Choose Start > All Programs > 
Adobe Audition CC.

•	 To start Adobe Audition in Windows 8 (64-bit): Click or touch the Audition 
CC tile on the Start screen.

•	 To start Adobe Audition in Mac OS X 10.7 or 10.8: Open the Applications/
Adobe Audition CC folder, and then double-click the Adobe Audition CC 
application icon.

Accessing the Classroom in a Book files
In order to work through the projects in this book, you will need to download the 
lesson files from peachpit.com. You can download the files for individual lessons, or 
download them all in a single file. Although each lesson stands alone, some lessons 
use files from other lessons, so you’ll need to keep the entire collection of lesson 
assets on your computer as you work through the book.

To access the Classroom in a Book files:

1	 On a Mac or Windows computer, go to www.peachpit.com/redeem and enter 
the code found at the back of your book.

2	 If you do not have a Peachpit.com account, you will be prompted to create one.

3	 The downloadable files will be listed on the Lesson & Update Files tab on your 
Account page. 

4	 Click the lesson file links to download them to your computer.

P	Note:  The Account 
page also contains 
one bonus lesson, 
Lesson 16, “Audio/Video 
Applications.” A PDF of 
this chapter is located 
in the Bonus Chapters 
folder listed under 
the Lesson & Update 
Files tab, and its lesson 
files are located in the 
Lessons folder.

http://www.adobe.com/products/audition/tech-specs.html
http://www.peachpit.com/redeem
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Restoring default preferences
The preferences files store information about panel and command settings. Each 
time you quit Adobe Audition CC, the positions of the panels and certain com-
mand settings are recorded in the respective preferences file. Any selections you 
make in the Preferences dialog box are also saved in the preferences file.

Many lessons recommend restoring a particular set of preferences so that what you 
see onscreen matches the images and instructions in this book. However, one of 
Audition’s great features is the ease with which you can customize a workspace to 
your needs, so feel free to adopt whatever layout you like. Just be aware that your 
screen may not match the images in the book exactly.

Additional resources
Adobe Audition CC Classroom in a Book is not meant to replace documentation 
that comes with the program or to be a comprehensive reference for every feature. 
Only the commands and options used in the lessons are explained in this book. 
For comprehensive information about program features and tutorials, please refer 
to these resources:

Adobe Audition Help and Support: www.adobe.com/support/audition is where 
you can find and browse Help and Support content on adobe.com. Adobe Audition 
Help and Adobe Audition Support Center are accessible from Audition’s Help menu.

Adobe Creative Cloud Learning: For inspiration, key techniques, cross-product 
workflows, and updates on new features, go to the Creative Cloud Learn page 
https://helpx.adobe.com/creative-cloud/tutorials.html. This is available only to 
Creative Cloud members.

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions, 
questions, and answers on Adobe products. The Audition forum is accessible from 
Audition’s Help menu.

Adobe TV: tv.adobe.com is an online video resource for expert instruction and 
inspiration about Adobe products, including a How To channel to get you started 
with your product. 

Adobe Design Center: www.adobe.com/designcenter offers thoughtful articles 
on design and design issues, a gallery showcasing the work of top-notch designers, 
tutorials, and more.

http://www.adobe.com/support/audition
https://helpx.adobe.com/creative-cloud/tutorials.html
http://www.adobe.com/designcenter
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Resources for educators: www.adobe.com/education and http://edex.adobe.com 
offer a treasure trove of information for instructors who teach classes on Adobe 
software. Find solutions for education at all levels, including free curricula that use 
an integrated approach to teaching Adobe software and can be used to prepare for 
the Adobe Certified Associate exams. 

Also check out these useful links: 

Adobe Audition CC product home page: www.adobe.com/products/audition.

Adobe Labs: labs.adobe.com gives you access to early builds of cutting-edge 
technology, as well as forums where you can interact with the Adobe development 
teams building that technology and other like-minded members of the community.

Audition and social media
For the latest news and Audition-related events, follow Adobe Audition on Twitter at 
twitter.com/#!/Audition. The Twitter feed is also accessible from Audition’s Help menu.

You can also find Adobe Audition on Facebook at www.facebook.com/
AdobeAudition. This Facebook page is also accessible from Audition’s Help menu.

Adobe certification
The Adobe training and certification programs are designed to help Adobe custom-
ers improve and promote their product-proficiency skills. There are four levels 
of certification:

•	 Adobe Certified Associate (ACA)

•	 Adobe Certified Expert (ACE)

•	 Adobe Certified Instructor (ACI)

•	 Adobe Authorized Training Center (AATC)

The Adobe Certified Associate (ACA) credential certifies that individuals have the 
entry-level skills to plan, design, build, and maintain effective communications 
using different forms of digital media.

The Adobe Certified Expert program is a way for expert users to upgrade their 
credentials. You can use Adobe certification as a catalyst for getting a raise, finding 
a job, or promoting your expertise. 

http://www.adobe.com/education
http://edex.adobe.com
http://www.adobe.com/products/audition
http://www.facebook.com/
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If you are an ACE-level instructor, the Adobe Certified Instructor program takes your 
skills to the next level and gives you access to a wide range of Adobe resources.

Adobe Authorized Training Centers offer instructor-led courses and training 
on Adobe products, employing only Adobe Certified Instructors. A directory of 
AATCs is available at http://training.adobe.com/training/partner-finder.html.

For information on the Adobe Certified programs, visit http://training.adobe.com/
home.html.

http://training.adobe.com/training/partner-finder.html
http://training.adobe.com/home.html
http://training.adobe.com/home.html
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Audio Interfacing 

Lesson overview
In this lesson, you’ll learn how to do the following:

•	 Configure a Macintosh computer’s onboard audio for use 
with Audition

•	 Choose the appropriate sample rate for a project 

•	 Set up the onboard audio on Windows computers for use 
with Audition

•	 Set up Windows audio interfacing for 64-bit versions 
of Windows 7 and Windows 8

•	 Configure Audition to work with Macintosh or Windows computers

•	 Test your configurations to make sure all connections are correct

This lesson will take about 45 minutes to complete. There are no 
audio lesson files because you’ll be recording your own files to test 
the interface connections. 

1



9

Before you can use Audition, you need to configure 
your Mac or Windows computer and audio system 
to work with the program.
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Audio interface basics
Recording audio into a computer requires converting audio signals into digital 
data that your computer and Audition can recognize. Similarly, playback requires 
converting that digital data back to analog audio so you can hear it. The device that 
performs these conversions is usually called a sound card when it’s built into the 
computer or an audio interface if it’s an external piece of hardware. Both include 
analog to digital (A/D) and digital to analog (D/A) converters. In addition, software 
drivers handle communications between your computer and audio hardware.

This chapter concentrates on a computer’s onboard audio capabilities, because the 
same concepts translate to more sophisticated (and higher-performance) audio 
interfaces. Note that there are many brands and models of audio interfaces, making 
universally applicable lessons impossible. As a result, multiple sidebars in this chapter 
explain audio interface characteristics to provide important background information.

Several lessons in this chapter are divided into versions for Macintosh and 
Windows computers. You won’t need to read the Windows-specific lessons if you 
use a Mac, and vice versa. However, all users should read the sidebars, because they 
cover information that’s applicable to both platforms.

To make the best use of the lessons in this chapter, you’ll need the following:

•	 An audio source, such as a portable music player (iPod, iPhone, Android, CD, 
etc.) with a 1/8-inch minijack output, or other device with a suitable adapter 
to provide a 1/8-inch minijack output. Laptops may also have an internal 
microphone you can use; however, using a line-level device is recommended, 
and the lessons will reference that type of input. You can also use USB 
microphones that plug directly into a computer’s USB port; however, note that 
they may introduce significant latency, as described later in this chapter, when 
used as class-compliant devices with Windows computers.

•	 Patch cable with a male-to-male 1/8-inch plug to connect the audio source to 
your computer’s audio input jack.

•	 Your computer’s internal speakers for monitoring or earbuds/headphones with a 
1/8-inch stereo plug suitable for plugging into your computer’s stereo output. You 
can also patch the output to a monitoring system if you have suitable cables.

P	Note:  If you have 
not already downloaded 
the project files for this 
lesson to your computer 
from your Account page, 
make sure to do so now. 
See “Getting Started” 
at the beginning of 
the book.
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Common audio interface connectors
The following are the most common input and output connectors found in comput-
ers and audio interfaces:

•	 XLR jack. This is compatible with microphones and other balanced-line signals. 
Balanced lines use three conductors, which can be designed to minimize hum 
and noise pickup when they are carrying low-level signals.

•	 1/4-inch phone jack. This is common with musical instruments and most pro 
audio gear. The jack can handle balanced or unbalanced lines; balanced line 
inputs can handle unbalanced lines as well. Headphone jacks also use 1/4-inch 
phone jacks. 

•	 Combo jacks. A fairly recent introduction, a combo jack can accept either an 
XLR or 1/4-inch phone plug.

•	 RCA phono jack. A mainstay of consumer audio gear, RCA jacks are also found 
in some DJ audio interfaces and video equipment. 

•	 1/8-inch minijack. This is common for onboard computer audio, but rare for 
external interfaces except when included to interface with MP3 players and 
similar consumer devices. The 1/8-inch minijacks sometimes provide headphone 
outputs as well.

•	 S/PDIF (Sony/Philips Digital Interconnect Format). This consumer digital 
interface typically uses RCA phono jacks but can also use an optical connector 
and (very rarely) XLR.

•	 AES/EBU (Audio Engineering Society/European Broadcast Union). This is a 
professional-level digital interface that uses XLR connectors. 

•	 ADAT (Alesis Digital Audio Tape) optical. This optical connector carries 
eight channels of digital audio. It’s used most commonly with interfaces for 
expanding the interface’s inputs; for example, if you have an interface that lacks 
sufficient mic inputs but has an ADAT input, eight-channel mic preamps are 
available that send their outputs to an ADAT connector. This allows for easily 
adding eight mic inputs to an existing interface.

Mac OS X audio setup
This lesson describes how to configure Audition to work with the Macintosh’s 
inputs and outputs. Audition Creative Cloud supports Mac OS X 10.7 and 10.8 
(Lion and Mountain Lion, respectively). 

1	 Connect the audio source to the Mac’s 1/8-inch line input jack via the 1/8-inch 
patch cord. If you’re not using internal speakers, plug the earbuds/headphones 
or monitoring system input into the Mac’s line-level output or headphones jack.

2	 Open Audition and choose Audition > Preferences > Audio Hardware.

P	Note:  Audition 
can run under Mac 
OS X 10.6.8 but is 
not supported and 
requires you to disable 
DLMS support. Choose 
Preferences > Media 
and Disk Cache, and 
then deselect Enable 
DLMS Format Support.
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3	 Don’t change the Device Class or Master Clock preferences, because they will 
default correctly. The Default Input drop-down menu lists all available audio 
inputs. Choose Built-In Line Input. 

4	 The Default Output drop-down menu lists all available audio outputs. If you’re 
using the built-in speaker, choose Built-In Output; for the line-level output, 
choose Built-In Line Output. 

5	 I/O Buffer Size determines the system latency. (See the sidebar “About latency 
[computer-based delay] for more information.) Low values result in less delay 
through the system, whereas higher values increase stability. A value of 512 
samples is a good compromise. 

6	 In the Sample Rate drop-down menu, choose 44100, which is the standard for 
CDs. The Sample Rate drop-down menu lists all available sample rates. For 
most Macs, the choices are 44100, 48000, 88200, and 96000kHz. (In theory, 
higher sample rates improve fidelity, but the difference is subtle at best.) 
Windows computers and external audio interfaces generally offer a wider 
choice of sample rates.

7	 Click Settings to open the Mac OS Audio/MIDI Setup dialog box, and then 
click Built-in Line Input.

The settings will mimic what you set in Preferences (e.g., if you selected a 
44.1kHz sample rate, this will appear as the sample rate in the Format field).

8	 In the other Format field, choose 2-channel, 24-bit, which specifies Bit 
Resolution. All Mac OS X audio-related parameters are now set.

9	 Close the Audio Devices dialog box, and click OK in Audition’s Preferences 
dialog box.

P	Note:  Compared 
to the Mac’s Sound 
setup under System 
Preferences, the 
Audio/MIDI Setup 
accessed by clicking 
Audition’s Settings 
button (Preferences > 
Audio Hardware) offers 
additional level controls, 
the option to mute 
inputs, and the ability 
to click on any input or 
output and examine its 
characteristics.
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10	Choose Audition > Preferences > Audio Channel Mapping to correlate Audition’s 
channels to the hardware inputs and outputs. For example, Audition’s 1(L) 
channel will be mapped to Built-in Output 1. Click OK to close this dialog box.

The next sections relate to the Windows setup, so proceed to the section “Testing 
inputs and outputs with Audition (Mac or Windows).”

About latency  
(computer-based delay)
Latency occurs in the conversion process from analog to digital and digital to analog, 
as well as in the computer: Even the most powerful processor can do only so many 
millions of calculations per second and sometimes can’t keep up. As a result, the com-
puter stores some of the incoming audio in a buffer, which is like a savings account 
for your audio input signal. When the computer is so busy elsewhere that it misses 
handling some incoming audio, it makes a “withdrawal” from the buffer instead.

The larger the buffer (measured in samples or milliseconds), the less likely the com-
puter will run out of audio data when it’s needed. But a large buffer also means that 
the input signal is being diverted for a longer period of time before being processed 
by the computer. As a result, if you listen to the audio coming out of the computer, it 
will be delayed compared to the input. For example, if you’re monitoring your vocals, 
what you hear in your headphones will be delayed compared to what you’re singing, 
and this can be distracting. Reducing the Sample Buffer value minimizes delay at the 
expense of system stability (you may hear clicking or popping at low latencies). 

P	Note:  The mapped 
defaults seldom need to 
be changed; however, 
you can remap if (for 
example) you were 
given a file in which the 
right and left channels 
were accidentally 
reversed: Map 
Audition’s 1(L) channel 
to the Built-in Output 2, 
which connects to the 
physical right output.
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Bit resolution
Bit resolution expresses the accuracy with which the analog-to-digital converter 
measures the input signal. A good analogy is the relationship between pixels and 
image resolution: The more pixels in images of the same size, the more detail you’ll 
see in the picture.

CDs use 16-bit resolution, which means that audio voltages are defined with an 
accuracy of approximately 1 part in 65,536. A resolution of 20- or 24-bit provides 
a higher level of accuracy, but as with higher sample rates, higher bit resolution 
requires more storage: A 24-bit file is 50 percent larger than a 16-bit file if both are 
at the same sample rate. Unlike higher sample rates, few dispute that 24-bit record-
ing sounds better than 16-bit recording.

Recording at 44.1kHz with 24-bit resolution is a common trade-off among storage 
space, ease of use, and fidelity.

Windows setup
Unlike newer Macs, Windows systems typically have several drivers: legacy 
drivers (primarily MME and DirectSound) for backward compatibility and higher-
performance drivers (WDM/KS, which is different from yet another driver type 
called WDM). However, for Windows music applications, the most popular high-
performance audio driver is ASIO (Advanced Stream Input/Output), created by 
software developer Steinberg. Virtually all professional audio interfaces include 
ASIO drivers, and many include WDM/KS drivers. 

Unfortunately, ASIO is not part of the Windows operating system, so for these 
lessons you’ll use the MME (Multimedia Extensions) protocol. It has relatively high 
latency but is stable and predictable. Experienced computer users can download 
the general-purpose ASIO driver ASIO4ALL, which is available free of charge from 
www.asio4all.com. It is the de facto ASIO driver for laptop owners who want to use 
ASIO with internal sound chips. Although you’ll use MME for now, with a profes-
sional audio interface, use the ASIO or WDM/KS drivers provided with it, or as an 
alternative, ASIO4ALL.

1	 Windows motherboards typically have mic and 1/8-inch line inputs. Connect 
the audio source to the computer’s 1/8-inch line input jack via the 1/8-inch 
patch cord. 

2	 If you’re not using internal speakers, plug the earbuds/headphones or 
monitoring system input into the computer’s line-level output.

E	Tip:  If there’s a 
microphone input 
and you’re not using 
it, make sure it’s not 
selected (or its fader is 
down) to prevent it from 
contributing any noise.

http://www.asio4all.com
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Audition on the Mac vs. Windows
Using a program on the Mac versus using it on Windows was once a hot topic, 
but over time, the operating systems and associated hardware have become more 
alike. When you open Audition, for all practical purposes, it operates identically on 
both platforms. 

Each platform has strengths and limitations. The Mac handles audio transparently, 
avoiding the multiple drivers found with Windows. However, independent bench-
marks show that all other factors being equal, Windows 7 can apply more power to 
audio projects than OS X. Realistically, though, with today’s computers the situation 
is analogous to saying that a car capable of going 270 mph is more powerful than a 
car that tops out at 250 mph—yet you probably won’t drive over 90 mph anyway.

Ultimately, if there are Mac-only or Windows-only programs that are essential for 
what you do, that will tend to dictate which platform is best. The reality is that both 
platforms have pretty much reached parity, and either will run Audition equally well.

Windows 7 and 8 assignments
This lesson describes how to configure Audition to work with a typical Windows 7 
or 8 machine’s inputs and outputs. Audition supports 64-bit versions of Windows 7 
and 8, but does not support any version of Windows XP.

1	 In Windows 7, choose Start > Control Panel, and then in the Control panel 
double-click the Sound icon. With Windows 8, press the Windows key+X, 
choose Control Panel, and click the Sound icon.

2	 Click the Playback tab. Click either Speakers or Headphones, depending on 
what you have plugged into the computer’s output jack. After clicking the 
appropriate choice, click the Set Default button to make this your default 
audio output. 

E	Tip:  Click the Sound 
Playback dialog box’s 
Properties. In the dialog 
box that appears, 
click the Levels tab, 
adjust the volume and 
balance, and also mute 
the output.
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3	 Click the Sound dialog box’s Recording tab.

4	 Click Line In, and then click Set Default. Click the Sounds tab, and for Sound 
Scheme, choose No Sounds. It’s distracting to hear system sounds while you’re 
working with audio. Click OK.

Audition settings for Windows audio 
Now that the computer has been configured properly for the audio inputs and 
outputs, you need to configure settings in Audition as well.

1	 Open Audition, and choose Edit > Preferences > Audio Hardware.

2	 From the Device Class drop-down menu, choose MME.

3	 From the Default Input drop-down menu, choose the default input device (Line 
In) you specified previously; from the Default Output drop-down menu, choose 
the default output device (Speaker or Headphones) you specified previously. 
Do not change the Master Clock preference. 

4	 Choose a latency value of 200ms, which is a “safe” value for most computers. 
Latency determines the delay audio experiences as it passes through the 
computer. Low values result in less delay through the system, whereas high 
values increase stability. 

5	 In the Sample Rate drop-down menu, choose 44100 (in theory, higher sample 
rates improve fidelity, although few people can hear a difference). The Sample 
Rate menu lists all available sample rates. Most Windows internal audio chips 
offer a wide variety of sample rates, often from 6000Hz to 192000Hz. External 
audio interfaces typically offer fewer options that are intended for professional 
audio and video projects. After selecting the Sample Rate, click OK.

6	 Choose Edit > Preferences > Audio Channel Mapping to correlate Audition’s 
channels to the hardware inputs and outputs. For example, Audition’s 1(L) 
channel will be mapped to Line 1. Click OK to close this dialog box.

E	Tip:  Click the Sound 
Recording dialog box’s 
Properties. In the dialog 
box that appears, 
click the Levels tab, 
adjust the volume and 
balance, and also mute 
the input.
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Common sample rates
Different sample rates are typically used for different applications. This list contains 
the most common sample rates used for pro audio:

•	 32,000 (32kHz). Typically used for digital broadcast and satellite transmissions.

•	 44,100 (44.1kHz). The sample rate for CDs and most consumer digital audio.

•	 48,000 (48kHz). The most common sample rate used in broadcast video.

•	 88,200 (88.2kHz). Some engineers claim this sounds better than 44.1kHz but is 
rarely used.

•	 96,000 (96kHz). Sometimes used in DVDs and other high-end audio recording 
processes.

•	 176,400 and 192,000 (176.4 and 192kHz). These ultra-high sample rates 
generate much larger files and stress your computer more, yet offer no 
significant audio advantage.

Testing inputs and outputs with 
Audition (Mac or Windows)
Because you already specified default inputs and outputs in the previous lessons, 
Audition will default to using these for recording and playback. Now you’ll test 
these connections to ensure that the inputs and outputs are set up properly.

1	 Choose File > New > Audio File to create a new file in the Waveform Editor. 
A dialog box appears.

2	 Name the file. The sample rate should default to the value you selected in 
Preferences.

3	 Choose the number of channels. Their inputs will default to what you specified 
in Preferences. If you choose Mono, only the first channel of the input channel 
pair will be recorded. 

4	 The bit depth represents the project’s internal bit depth, not the bit resolution of 
your interface’s converters. This resolution will be used to calculate changes in 
volume, effects, and the like, so choose the highest resolution, which is 32 (float).

P	Note:  The mapped 
defaults for channel 
mapping seldom 
need to be changed. 
However, you can 
remap if (for example) 
you were given a file 
in which the right and 
left channels were 
accidentally reversed: 
Map Audition’s 1(L) 
channel to the Built-in 
Output 2, which 
connects to the physical 
right output.
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5	 Click OK to close the dialog box. 

6	 Click the Transport Record button, and then start playback from your audio 
source. If all connections are defined and all levels are set properly, you’ll see a 
waveform being drawn in the Waveform Editor window. Record several seconds 
of audio.

7	 Click the Move Playhead to Previous button in the Transport, or drag the 
playhead (also called the current time indicator [CTI]) back to the beginning 
of the file. Click Play, and you should hear what you recorded in your chosen 
output device (internal speakers, earbuds, headphones, or monitoring system). 
Click the Transport Stop button to end playback.

8	 Now test recording and playback in the Multitrack Editor. Choose File > New > 
Multitrack session. A dialog box appears.

9	 Name the file. For template, choose None. The sample rate should default to the 
value you selected in Preferences.

10	As with the Waveform Editor, choose the highest resolution of 32 (float), and 
then choose the number of output channels (Stereo) for the Master Track. 

11	Click OK to close the dialog box. 

12	Arm a track by clicking the R (Record) button. Start playing your audio source; 
the channel’s meter should indicate a signal. Note that the input will connect 
automatically to the default input; however, if you click the input field’s right 
arrow, you can choose just one input for mono tracks or you can open the 
hardware section under Preferences if you have a multi-input audio interface 
and want to choose an input other than the default.
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13	Click the Transport Record button. If all connections are defined and all levels 
are set properly, you’ll see a waveform being drawn in the Multitrack Editor 
window. Record several seconds of audio.

14	Click the Transport Move Playhead to Previous button, or drag the playhead 
back to the beginning of the file. Click Play, and you should hear what you 
recorded in your chosen output device (internal speakers, earbuds, headphones, 
or monitoring system). Click the Transport Stop button to end playback.

Using external interfaces
It’s not possible to present an exercise in this lesson, because there is no way to 
know which interface you’re using. However, keep the following in mind when 
you’re using external interfaces:

•	 Professional interfaces usually have capabilities beyond those offered by internal 
audio I/O and therefore have their own control panels for routing signals, 
controlling levels, and the like.

•	 Interfaces often have more than one set of stereo inputs and outputs. When 
you’re choosing default inputs and outputs, you’ll have a much wider selection 
compared to using a computer’s internal sound capabilities.

•	 With interfaces that provide various connections (USB, FireWire, Thunderbolt, 
etc.), try them all on extended sessions to determine if one option works better 
than the other.

•	 Windows USB interfaces can be class-compliant, meaning they don’t need 
custom drivers. However, always use the custom ASIO or WDM drivers 
provided with an interface for maximum functionality and minimum latency.

•	 With Windows computers, never use drivers called “emulated,” such as “ASIO 
(emulated).” These result in the worst performance of all possible drivers.

•	 Some interfaces include a feature called zero-latency monitoring. This means 
the input can be mixed directly to the output, and the mixing is typically 
controlled by using an applet that appears onscreen to bypass any latency 
caused by going through the computer. 

•	 With ASIO interfaces, Audition will default to monopolizing any sound 
capabilities. To access the ASIO interface in other applications that are running, 
choose Preferences > Audio Hardware, and select the “Release ASIO driver in 
background” check box in the dialog box. Giving the other application the focus 
will allow it use the ASIO interface, unless Audition is recording.
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Audio interface/computer connections
There are several ways external audio interfaces communicate with a computer: 

•	 USB. USB 2.0 can stream up to dozens of audio channels over a single cable that 
connects between the interface and a computer’s USB port. As of this writing 
there are no USB 3.0 audio interfaces, although virtually all USB 2.0 interfaces are 
compatible with USB 3.0. USB 1.1 interfaces are also available for less-demanding 
applications and can typically stream six channels of audio, making them suitable 
for surround. Class-compliant interfaces are plug and play, but most professional 
interfaces use specialized drivers to improve speed and efficiency.

•	 FireWire. Like USB, FireWire also connects the interface to your computer with 
a cable, although the connector configuration is different than USB. Although 
still common, FireWire has been eclipsed somewhat by USB for several reasons: 
Many laptops no longer include FireWire ports, most audio interfaces require 
specific FireWire chip sets, and the performance advantage FireWire once 
offered was more relevant when computers weren’t as powerful. Some audio 
interfaces include FireWire and USB 2.0. Note that there are two common 
FireWire speeds—FireWire 400 and FireWire 800 (which has roughly twice the 
bandwidth of FireWire 400).

•	 PCIe card. This plugs directly into a computer’s motherboard, so it provides the 
most direct pathway to a computer. However, this option is less common because 
USB and FireWire offer more convenience—you don’t need to physically open the 
computer to install the card—with virtually no performance decrease.

•	 ExpressCard. This is suitable for plugging into laptops that have ExpressCard 
slots but again is ceding its role to USB or FireWire interfaces. 

•	 Thunderbolt. This relatively recent interface protocol, which carries data 
over a cable, is becoming more common; it’s the only option, other than 
USB 3.0, on any newer Mac. Although few Thunderbolt-compatible interfaces 
are available as of this writing, Thunderbolt provides PCIe-type performance 
and compatibility with existing audio interfaces, as well as with dedicated 
Thunderbolt interfaces. 
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Review questions
1	 What are the most popular driver protocols for Mac and Windows?

2	 What is an unavoidable, negative by-product of working with computer-based audio?

3	 How can you minimize latency?

4	 What are the advantages and disadvantages of high sample rates and high bit resolutions?

5	 Although many external audio interfaces include ASIO drivers, the Windows operating 
system does not. How can you use ASIO with laptop sound chips?

Review answers
1	 Core Audio for the Mac and ASIO for Windows are the most popular driver protocols.

2	 System latency causes a time delay between the output and what’s being recorded at 
the input.

3	 Change the number of sample buffers to alter latency. Using the smallest number possible, 
consistent with the audio not producing clicks or pops, provides minimum latency.

4	 High sample rates and bit resolutions have the potential to deliver better audio quality but 
create larger audio files and stress the computer more than lower rates and resolutions.

5	 The free driver software, ASIO4ALL, provides ASIO drivers for sound hardware that 
was not designed for ASIO compatibility.
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The Audition Environment 

Lesson overview
In this lesson, you’ll learn how to do the following:

•	 Create custom workspaces for particular workflows 

•	 Arrange panels and frames for optimum workflow

•	 Use the Media Browser to find files on your computer 

•	 Listen to files before loading them using the Media Browser’s 
Playback Preview function

•	 Create shortcuts to frequently used folders

•	 Navigate to specific sections of a file in the Waveform Editor 
or a Session in the Multitrack Editor

•	 Use markers to create points you can jump to immediately in the 
Waveform Editor or a Session in the Multitrack Editor

•	 Use zooming to focus in on particular sections in the Waveform 
or Multitrack Editor

This lesson will take about 60 minutes to complete. Download the project 
files for this lesson from the Lesson & Update Files tab on your Account 
page at www.peachpit.com and store them on your computer in a conve-
nient location, as described in the Getting Started section of this book. 
Your Accounts page is also where you’ll find any updates to the chapters 
or to the lesson files. Look on the Lesson & Update Files tab to access the 
most current content. 

2

http://www.peachpit.com
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You can create custom workspaces with particular 
selections of windows and window arrangements, 
as well as choose various ways to navigate through 
Audition’s Waveform Editor and Multitrack Editor.


